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MDT  DOCUPLOT 
 
DocuPlot is a plotting solution meeting the needs of CADD designers, the 
contract plans section, and the print unit. DocuPlot supports local plotting and 
plotting from a CADD server for designers. DocuPlot supports the creation of 
electronic plan books for contract plans. DocuPlot supports full electronic plan set 
production for the print unit. 
 

1. TO OPEN DOCUPLOT 

1.1. MicroStation V8 
MicroStation must be running before DocuPlot will operate. MicroStation can be 
initialized and any file opened, or DocuPlot will open MicroStation and attach the 
file MDT.MAS. DocuPlot operates in conjunction with MicroStation.  Do not 
minimize MicroStation when using DocuPlot. MicroStation must have window 
one open for DocuPlot to print a local file. 

1.2. DocuPlot  
Go to the desktop and click DocuPlot shortcut. If MicroStation is not opened 
when DocuPlot is initialized, then MicroStation will be opened using the DocuPlot 
configuration for MicroStation V8 startup settings. The file MDT.MAS will be the 
active design file.  (See Section 6.8, Modify and Save MicroStation Startup STD 
Settings, pp.55). 
 
 
 

MicroStation can also be 
used to access DocuPlot. In 
MicroStation go to 
MDT>Docuplot.  
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1.3. W: Drive (CADDSTD or CADDTEST) 
DocuPlot will operate only when the w: drive is mapped correctly.  DocuPlot 
originates from the w:\\astro\cadddev\etc. 
 
 
 

 
 
 
 

 
 
 

 

 

W Drive must be attached to cadddev 
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 1.4        Adding DocuPlot Icon to Desktop 
A DocuPlot icon can be added to the desktop using the standard Windows XP 
process.  
 
 
    

1.4. 

Right mouse click on desktop screen 
Select New>Shortcut 
 

Select Next>Finish and DocuPlot 
Icon is added to desktop 
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1.5       DocuPlot Screen 
The DocuPlot screen has specific sections in the main dialog that relate to its 
major functions.   
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

User defined plotter defaults 

Contract Plan 
Book Options 
 

Plotter Selection Options 

Plot Commands 
User Preference 
settings 

Fence Coordinate / 
Sheet display options 

Closes DocuPlot 
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2. VIEWING LOCAL FILES 
Standard MDT file formats can be navigated using DocuPlot.  The navigation tool 
supports the following file formats; Three sheet, Bridge single sheet, Geopak 
Cross-Section sheets, 8.5 x 11 preservation project sheets, 8.5 x 11 vertical pres 
project sheets, 8.5 x 11 Traffic Signing Sheets. It is also possible to change the 
units from Metric to English and vice-versa. To navigate through a file using 
DocuPlot, the design file must be active in MicroStation.  

2.1. Viewing Standard Three Sheet plans using DocuPlot 
Open a MicroStation design file that has a same standard format as the Current 
Units.   
 
Page through the three sheets plans using the fence coordinates display option.  
Select the option to set the coordinates to three sheet.  This command places a 
window area on the half size or full size plotting coordinates and displays the 
contents in a MicroStation station window.  
 
Hint:  You may need to use the MicroStation  “fit all” or “fit view” command before 
using DocuPlot to view plan sheet contents.  
 
 
 
 
 
 
 
 

Select the sheet you want to view 
(1, 2, or 3).  This sheet will display 
in MicroStation. 

Go Options>Standard Fence 
Coordinates options>Three 
Sheet.   

DocuPlot loads standard three 
sheet coordinates into the lower 
right portion of the dialog. 

NOTE: 
Viewing fence coordinate contents 
using DocuPlot does not reflect 
reference file attachments.  You must 
open the MicroStation Reference File 
dialog to verify reference file 
attachment. 
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2.2. Viewing Standard Bridge Single Sheets using DocuPlot 
Open a MicroStation design file that has a standard single bridge sheet format.   
 
View the contents of the single sheet using the fence coordinates display option.  
Select the option to set the coordinates to Bridge Single sheet.  This command 
places a window area on the half size or full size plotting coordinates and 
displays the contents in a MicroStation window. 
 
Hint:  You may need to use the MicroStation  “fit all” or “fit view” command 
before using DocuPlot to view plan sheet contents.  
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select the single sheet you 
want to view.  This sheet will 
display in MicroStation. 

NOTE: 
Viewing fence coordinate contents using DocuPlot does not reflect 
reference file attachments.  You must open the MicroStation Reference 
File dialog to verify reference file attachment. 

Go Options>Standard Fence 
Coordinates>Bridge Single 
Sheet.  

DocuPlot loads standard 
bridge coordinates into the 
lower right portion of the 
dialog. 
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2.3. Viewing Standard GeoPak XS Sheets using DocuPlot 
Open a MicroStation design file that has a standard GeoPak Cross Section 
sheet format. 
 
View the contents of the metric Cross Section sheets using the fence 
coordinates display option.  Select the option to set the coordinates to GeoPak 
Cross-Section sheets.  This command places a window area on the half size or 
full size plotting coordinates and displays the contents in a MicroStation window. 
 
Hint:  You may need to use the MicroStation  “fit all” or “fit view” command 
before using DocuPlot to view plan sheet contents.  
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Select the sheet you want to view using the Scroll 
bar, the up or down buttons, or key in the specific 
sheet to view.  The selected cross section sheet 
will display in MicroStation. 

NOTE: 
Viewing fence coordinate contents using DocuPlot does not reflect 
reference file attachments.  You must open the MicroStation Reference 
File dialog to verify reference file attachment. 

Go Options>Standard 
Fence Coordinates> 
GeoPak Cross-Section 

DocuPlot loads standard 
cross section coordinates 
into the lower right portion of 
the dialog. 



DocuPlot Users Manual   June 25, 2004 
 

 - 11 - 

2.4. Viewing 8.5 x 11 Preservation Project Sheets using DocuPlot 
Open a MicroStation design file that has a standard Pavement Preservation 
sheet format.  
 
View the contents of the pavement preservation sheets using the fence 
coordinates display option.  Select the option to set the coordinates to 8.5 x 11 
Preservation Project sheets.  This command places a window area on the 8.5 x 
11 plotting coordinates and displays the contents in a MicroStation window. 
 
Hint:  You may need to use the MicroStation  “fit all” or “fit view” command 
before using DocuPlot to view plan sheet contents.  
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Select the sheet you want to view using the Scroll 
bar, the up or down buttons, or key in the specific 
sheet to view.  The selected cross section sheet 
will display in MicroStation. 

NOTE: 
Viewing fence coordinate contents using DocuPlot does not reflect 
reference file attachments.  You must open the MicroStation Reference 
File dialog to verify reference file attachment. 

Go Options>Standard Fence 
Coordinates> 8.5 x 11 
Preservation Project Sheets.  

DocuPlot loads standard 
8.5 x 11 coordinates into 
the lower right portion of 
the dialog. 
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2.5. Viewing 8.5 x 11 Vertical Preservation Project Sheets using 
DocuPlot 

 
Open a MicroStation design file that has a standard Vertical Preservation sheet 
format.  
 
View the contents of the pavement preservation sheets using the fence 
coordinates display option.  Select the option to set the coordinates to 8.5 x 11 
Preservation Project sheets.  This command places a window area on the 8.5 x 
11 plotting coordinates and displays the contents in a MicroStation window. 
 
Hint:  You may need to use the MicroStation  “fit all” or “fit view” command 
before using DocuPlot to view plan sheet contents.  
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Select the sheet you want to view using the Scroll 
bar, the up or down buttons, or key in the specific 
sheet to view.  The selected cross section sheet 
will display in MicroStation. 

NOTE: 
Viewing fence coordinate contents using DocuPlot does not reflect 
reference file attachments.  You must open the MicroStation Reference 
File dialog to verify reference file attachment. 

Go Options>Standard Fence 
Coordinates> 8.5 x 11 
Vertical Pres Project Sheets.  

DocuPlot loads standard 
8.5 x 11 coordinates into 
the lower right portion of 
the dialog. 
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2.6. Viewing 8.5 x 11 Traffic Signing  Sheets using DocuPlot 
Open a MicroStation design file that has a standard traffic sign design sheet 
format.  
 
View the contents of the traffic sign design sheets using the fence coordinates 
display option.  Select the option to set the coordinates to 8.5 x 11 traffic sign 
design sheets.  This command places a window area on the 8.5 x 11 plotting 
coordinates and displays the contents in a MicroStation window. 
 
Hint:  You may need to use the MicroStation  “fit all” or “fit view” command 
before using DocuPlot to view plan sheet contents.  
  
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Select the sheet you want to view using the Scroll 
bar, the up or down buttons, or key in the specific 
sheet to view.  The selected cross section sheet 
will display in MicroStation. 

NOTE: 
Viewing fence coordinate contents using DocuPlot does not reflect 
reference file attachments.  You must open the MicroStation Reference 
File dialog to verify reference file attachment. 

Go Options>Standard Fence 
Coordinates> 8.5 x 11 Traffic 
Signing Sheets.   
 

DocuPlot loads standard 
8.5 x 11 coordinates into 
the lower right portion of 
the dialog. 
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3. LOCAL PLOTTING 
DocuPlot’s Local plotting option allows MicroStation users the ability to plot any 
MDT standard sheet format.  This includes Three sheet, Bridge single sheet, 
Geopak Cross-Section sheets, 8.5 x 11 preservation project sheets, 8.5 x 11 
vertical pres project sheets, 8.5 x 11 Traffic Signing Sheets design calculations.  
The design file must be active in MicroStation. 
 

3.1. Open Design file using MicroStation 
Use any accepted method to open a MicroStation design file. 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 

 
 
 

Use File>Open command in 
MicroStation to attach a design 
file, or choose off the list of last 
opened files. 

Any option to open a design file 
will work. 
Control O 
Keyin “dialog Openfile” 
Keyin “rd=filename” 
Choose off file list  
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3.2. Open Design File using DocuPlot 
DocuPlot has the option of opening MicroStation design files. 
 

 
 

 
 
 
 
 

 

Active MicroStation design file 

Select * button to open other design files 
using Windows XP Explorer format. 

NOTE: 
Filter setting determined by DocuPlot user settings. (See Section 6.8, 
Modify and Save MicroStation Startup STD Settings, pp.55). 

Select local directory and 
file, (defaults to c:\dgn).  
Double click the file or 
select Open. 
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3.3.  Plot Current Design File Option 
Any active MicroStation design file can be plotted using DocuPlot.  Plot Current 
Design File will plot standard three sheet plans, standard cross section sheets, 
and standard 8 ½ x 11 sheets.  
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Sheet selection options 
 
Plot options 
 
Cross Section and  
8 ½ x 11 options 
 
Select If you need Duplex or if 
you need all pages together 
 
Select plan sheet options 
 
Select Plotter options 
 
Use Default is Windows Default 
printer set in Windows XP 
(Start>Setting>printer) 
 

NOTE: 
All active design files can be plotted using 
DocuPlot.   
 
Plot current design file uses local files on 
c:\dgn. 

Select PLOT CURRENT 
DESIGN FILE (Button or 
menu). 
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3.4. Select Sheet Style and Size 
Determine the sheet type for plotting, (Half Size, Full Size or 8 ½ x 11).  Select 
the sheet size, number of copies, and grey scale options. 
 
 
 
 
 
 
  
 
 
  

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
  

THREE SHEET PLANS 

Select Half Size plan sheets, (default) or 
Full Size plan sheets. 

Select Plan sheets 
required.  When all 
sheets is selected the 
individual sheets will no 
longer be available for 
selection 

Determine Grey Scale 
and number of copy 
options. 
 

Cancel Returns to main 
DocuPlot dialog. 

Keep Fence will 
maintain the last 
fence placed used for 
plotting. 

SINGLE SHEET BRIDGE PLANS 

Select Bridge Single 
Sheet.  The three-sheet 
format will no longer be 
available for selection 

Select if you need 
Duplex or if you 
want to print all 
pages together 
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Select Half Size, 
(default) or Full 
Size cross-
section sheets. 

Select sheets 
required. 

Determine Grey Scale, 
fence, and copy 
options. 
 

CROSS SECTION SHEETS 
 

Check if Plotting 8.5 x 11 Sign 
Design sheets. 

8 ½ x 11 Traffic Sign Calculation Sheets 
 

Select 8.5 x 11 
sheets. 

Select sheets required 

Determine Grey Scale, 
fence, and copy 
options. 
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Select 8.5 x 11 
sheets. 

Select sheets required 

Determine Grey Scale, 
fence, and copy 
options. 
 

8 ½ x 11 Pavement Preservation Sheets 

(For creating MS word 
documents of Pavement 
Preservation jobs for 
Contract Plans, see 
section 3.14,3.14   
Pavement Preservation 
Projects for Contract 
Plans , pp 29).  
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3.5. Select Default Windows XP as Current Plotter 
You can set DocuPlot to print directly to your default Windows XP plotter.  A 
plotter must be attached in the printers dialog as default. 

 
   

  
 
 

 
 

 
 
 
 

Current plotter is now set as default 
Windows XP printer. 

Current plotter selected for 
specified sheet size.  

Set a printer as 
default in Windows 
XP printer dialog. 
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3.6. Select Network Half Size Plotter 
Half size plotters can be selected for plan sheets or cross sections.  Half size 
plotters are segregated by location (Helena or District), and by work area, 
(Helena area office or District office).  
 
Plotters do not need to be added to the Windows XP printer selections.  Plotters 
are accessed at the server level and not attached locally.  
 

  
 

 
 

 
 
 
 

 
 

 

Default DocuPlot Plotters for 
half size, full size and 8.5 x 11 
sheets.   
(For default plotter 
attachments, see section 6.2,  
U####.ini Plotter Settings,   
pp 49). 
 

Current plotter selected for 
specified sheet size.  

Change Plotter will select a new 
plotter.   
Select Plotter by choosing 
Helena or District, choosing 
Design Area and selecting 
plotter. 
 

Select Half Size 
Plans or half 
size cross 
sections 

OK sets selected 
half size plotter as 
Current Plotter  
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3.7.  Select Network Full Size Plotter 
Full size plotters can be selected for plan sheets or cross sections.  Full size 
plotters are segregated by location (Helena or District), and by work area, (Helena 
area office or District office).  
 
Plotters do not need to be added to the Windows XP printer selections.  Plotters 
 are accessed at the server level and not attached locally. 
 

 
 

  
 

 
 
 

Current plotter selected for 
specified sheet size.  

Select Full Size 
Plans or Full 
Size Cross 
Sections 

OK sets selected full 
size plotter as 
Current Plotter  

Default DocuPlot Plotters for 
half size, full size and 8.5 x 11 
sheets.   
(For default plotter 
attachments, see section 6.2, 
U####.ini Plotter Settings,  
pp 49). 
 

Change Plotter will select a new 
plotter.   
 
Select Plotter by choosing 
Helena or District, choosing Design 
Area and selecting plotter. 
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3.8. Select Network 8.5 x 11 Plotter 
8.5 x 11 plotters can be selected for appropriate sheets.  8.5 x 11 plotters are 
segregated by location (Helena or District), and by work area, (Helena area office 
or District office).  
 
Plotters do not need to be added to the Windows XP printer selections.  Plotters 
are accessed at the server level and not attached locally. 
     
 
   
 
  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Current plotter selected for 
specified sheet size.  

Select 8.5 x 11 
sheets 

OK sets selected 
8.5 x 11 plotter as 
Current Plotter  

Default DocuPlot Plotters for 
half size, full size and 8.5  x 11 
sheets.   
(For default plotter 
attachments, see section 6.2,  
U####.ini Plotter Settings,   
pp 49). 
 

Change Plotter will select a new 
plotter.   
 
Select Plotter by choosing 
Helena or District, choosing Design 
Area and selecting plotter. 
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3.9. Submitting Plots Using DocuPlot 
Once you selected the sheet size requirements, (size, grey scale, copies) and 
selected a plotter click OK to submit the plots to the printer queue.  DocuPlot 
activates MicroStation’s fence and plot command, submitting the requested plots.  
 
      

 
 
 
 
 

 

Select OK to print, 
and return to main 
DocuPlot dialog. 

Select Cancel to stop local print 
option, and return to main 
DocuPlot dialog. 
. 

Half and Full Size Cross section print requests 

3 sheet plans, single bridge sheets, and 8 ½ x 11 
sheet requests 

Select OK, opens 
the Cross Section 
Request form  

Fill in the 
required 
information 
if using the 
printers 
listed 

Both OK and CANCEL submit the cross section 
plot request. 
 
OK – Places a cover sheet with name, area and 
phone number information in the submit request. 
 
CANCEL – Submits request without cover sheet. 
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3.10. Reference Files that DO NOT Plot 
Occasionally the reference files attached to a design file do not plot.  Check first 
to see if the reference files are named correctly and reside in the c:\dgn\ref 
subdirectory.  If the files simply do not plot, yet show on the MicroStation screen, 
go to DocuPlot’s Utility > Ignore Update Sequence when Plotting.  This utility 
changes a setting in the active session of MicroStation for each plot.  After each 
plot the setting reverts to its default setting. 
 
 
 
 
 
 
 
 
 
 
 

Use only if reference 
files do not plot.  

Changes your User Preference setting for 
the active session of MicroStation.  The 
setting will toggle on and off for each plot 
submitted. 
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3.11. Plot Current Fence with DocuPlot 
After placing a fence in an active MicroStation design file the fence contents can 
be plotted using the PLOT CURRENT FENCE option.  Users can determine Grey 
Scale and number of copies.  The Keep Fence option will keep the fence in place 
after the plot is submitted.  The user can specify the plotter. This command 
activates MicroStation’s fence and plot command, using the existing fence 
coordinates and submits the plot.  
 
  

 

Place a fence in design 
file of area wanting to 
plot. 

Select Cancel to stop local print 
option, and return to main 
DocuPlot dialog. 
. 

Determine number of 
copies and Grey Scale. 
 
Keep Fence option will 
maintain fence after 
plotting is completed 

Determine 
plot size 

Determine 
plotter 

Plot Current Fence uses existing 
fence, and submits the plot to 
requested plotter.  Default print will 
be landscape. 
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3.12. Preview and Plot Current Fence with DocuPlot  
After placing a fence in an active MicroStation design file the fence can be 
plotted using the PLOT CURRENT FENCE option.  Users can preview and rotate 
the image using MicroStation’s Plot Preview dialog.   Set the plot requirements in 
DocuPlot, switch to MicroStation and set the rotation, return to DocuPlot and 
submit the plot. 
 
  

Determine 
plot size 

Determine 
plotter 

Toggle Use Plot Preview, 
and then click Plot Current 
Fence 

Place fence in design file to 
define plotting area. 

Select Type of Layout 

Select OK to finish  
plotting 
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3.13. Plot Current Fence with MicroStation 
If DocuPlot was used to submit plots, then you decide to plot using MicroStation’s 
plotting command the plotter driver may need to be reset.  
    

3.14. 

Determine 
plot size 

Place a fence in design 
file of area wanting to 
plot. 

Select appropriate Plotter 
Driver, select OK, and then 
plot as usual.   

Activate MicroStation Print/Plot  
(Ctrl+P) 

Plotter driver will reflect the driver 
DocuPlot used.  Select Plotter Driver 
icon and change to appropriate driver 

NOTE: To plot using 
MicroStation print/plot the plotter 
must be attached in the 
Windows XP printer dialog.  
(Start>Settings>Printers) 
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3.14   Pavement Preservation Projects for Contract Plans 
Send pavement preservation projects to Contract Plans in a MS Word document 
containing all the design sheets.  This document is created using the 8.5 x 11 
sheet size and using the To Contract Plans option.  Open a Pavement 
preservation file in MicroStation, select plot current file, select sheet size and 
sheets required.  Toggle the To Contract Plan option and follow the prompts.  A 
MS Word document is created using plot images from MicroStation and an 
Outlook message will be sent to Contract Plans.  

Prompts will be asking for control number, design 
area and class type.  
 
These prompts build the file name for a MS Word 
Document. 
 

MicroStation Pavement 
Preservation design file Select 8.5 x 11 sheets 

Select To Contract 
Plans to create a MS 
Word document 
using Pavement 
Preservation 
Sheets. 

Determine sheets 
required to plot for 
entire project. 

Choose a plotter 
only when needing 
prints of the project 

CONTINUED ON 
NEXT PAGE 
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Prompt requires decision to create a 
MS Word document using images of 
the pavement preservation project 

Prompt requires decision to plot the 
pavement preservation project to 
current plotter. 

MS Word (Preview) opens and the 
EMF images are inserted into the 
document.  The document will close 
upon completion. 

An Outlook message will be sent to 
Contract Plans informing them of the 
project.  You receive a cc of the 
message. 

Both SEND MESSAGE and CANCEL submit the pavement preservation job request. 
 
Send Message sends the mail message and the pavement preservation job. 
 
Cancel sends only the pavement preservation job. 
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4. LOAD EXISTING CONTRACT PLANS BOOK 
A Contract Plans Book is an electronic MicroStation plan sheet record containing 
sequential page information.  Each CPB page is a record of the CADD server, 
the MicroStation design file, and specific fence coordinates for the plan sheet. 

4.1. Load Existing Contract Plans Book (CPB) 
A CPB is normally stored on a CADD server, in the appropriate Project \ Design 
area.  Copy the CPB from the CADD server to the local c:\dgn directory using 
DMS. 

 
 
 

Select Load Book and all 
options become active. 

Select local folder and 
file, (defaults to c:\dgn).  
Double click the file or 
select Open. 

NOTE: 
Filter set to display only *.cpb files 
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4.2. Loaded Contract Plans Book Parameters 
Each CPB had individual parameters that are stored in the electronic book.   
 
   

 NOTE:  
All items grayed out cannot be changed.  This portion of the 
DocuPlot Screen is for user information. Changes made in 
other DocuPlot dialogs will appear in this screen. 

File Server 

Plotter 

Plotter server 

CPB Creator 

Project No. 

CADD Server 

Plot Configuration 
file 

Current CPB MicroStation 
Design File displayed.   

MicroStation 
View used 

Sheet size 
Selected 

Number of 
Copies 

Rotation of Plot 

Design Area 
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4.3. Loaded Existing Cpb File 
A CPB is an electronic database that is loaded into DocuPlot.  A CPB remembers 
only three pieces of information; (1) CADD server, (2) MicroStation file and (3) 
sheet coordinates. 
 
 
 
 
 
 
 
 
 
 

Loaded Contract Plan Book (.cpb) 

Scrolling though the book loads pages of the 
CPB file into MicroStation.  The file loaded by 
DocuPlot is the active MicroStation file. 

Page in CPB is record of: 
CADD Server 
MicroStation File 
Sheet Coordinates 

MicroStation File 

Sheet Coordinates 

CADD Server 
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4.4. CPB and MicroStation Design Files 
The CPB is only a record of the CADD server, file name and the coordinates of 
specific sheets.  The MicroStation Design files must be in the local C:/dgn 
directory and the attached reference files must be in the c:\dgn\ref subdirectory.  
If the files are not local they must be copied from the CADD server.  To 
determine the files needed on the local drive check DocuPlot’s List Contract Plan 
Book Page Information utility. 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A *.lst file is created on the c:\dgn directory.  This 
file lists the Project, Design Area, and File.  Copy 
files from CADD server to the local c:\dgn drive.  
The attached reference files will be copied to the 
c:\dgn\ref directory 

List of files needed on the 
local c:\dgn (Call CADD 
Support for File Transfer 
Information.) 
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4.5. Paging through an Existing CPB File  
Similar to a traditional paper book, the user may flip through pages in an 
electronic Contract Plan Book.  In order to page though all pages the files and 
reference files must exist on the local PC. 
 
 
 
 

Selecting new CPB page 
loads new active design file 
into MicroStation. 

Select new page by key in. 

 NOTE:  
Each time a new page is selected, the design file is 
loaded into MicroStation.  The file and any reference files 
must exist in the appropriate local PC directory. 

Select new page by sliding scroll bar. 
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4.6. Location of CPB Design and Reference Files 
When DocuPlot opens a new CPB page, MicroStation loads the active design file 
and attached reference files. The active file must be in the local c:\dgn\ directory.  
The reference files must be in the local c:\dgn\ref directory. 
 
 
 
 
 
 
 
 
 
 
 

 

MICROSTATION DESIGN FILES 
 

For the CPB page to display in 
MicroStation the file must exist on the 
local c:\dgn\ directory. 

CONTINUED ON 
NEXT PAGE 
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MICROSTATION REFERENCE FILES 
 

For the CPB page to display the 
reference files in MicroStation, the files 
must exist on the local c:\dgn\ref 
directory. 

The Reference File window can be 
opened by going to MicroStation and 
clicking on File>Reference. 
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4.7. Paging through an Active Design file in a CPB  
You may view standard metric sheets in an active MicroStation design file while 
in CPB.   
 
 
 
 
 
 
 
 
 

Active local file in MicroStation  
 

Update MicroStation Fence 
works like MicroStation refresh 
view command however does not 
minimize the DocuPlot dialog. 

Sheet buttons allow paging to 
specific metric sheets.  This 
option is independent of the CPB 
file. 
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4.8. Design File Not Found  
When DocuPlot cannot find a file in the local c:\dgn directory, DocuPlot will 
display MDT.MAS.  Fixing this situation requires placing the file in the local c:\dgn 
directory. 
  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

DocuPlot CPB parameters displays the file 
listed in the CPB sequence.  DocuPlot looks in 
the c:\dgn directory. 

If a design file cannot be found local, 
Docuplot asks if you want to copy it to 
the C:\dgn directory. MDT.MAS will be 
displayed in MicroStation if you say 
no. 

When you click yes, the 
file gets copied to the 
C:\dgn directory and gets 
displayed. 
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5. PLOTTING EXISTING CPB 
A contract plan book has versatility in how it is plotted.  A book may be loaded 
into DocuPlot at the local level and plotted by page, by series of pages, or in it’s 
entirety using local files or server files.  DocuPlot will also launch plots entirely 
from the server, never using MicroStation files at the local level. 

5.1. Four Plotting Options 
DocuPlot can plot standard sheets from any local MicroStation design file, and 
supports three CPB plotting options.  
   
 
 
 
.  
 
 
 
 
 
 
 

 

PLOT CURRENT CPB PAGE 
Plots the current CPB page, 
(design file sheet) displayed in 
MicroStation.  The file plotted 
is the local version. 

PLOT CPB FROM NETWORK 
Plots pages requested from the 
CPB from files located on the 
server.  Uses the current 
version of the design file and 
reference files located on the 
server.  Does not bring files up 
to local machine. 

PLOT CURRENT DESIGN FILE 
Functions like MicroStation’s fence and 
plot.  Plots only local copy of the files. 

PLOT CPB FROM LOCAL 
Plots the pages requested 
from the CPB.  Loads each 
design file and reference 
files in MicroStation, creates 
plot files of requested sheets 
and submits to plotter. 

1 

2 3 

4 
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5.2. Plot Current Design File 
DocuPlot’s Local plotting option allows MicroStation users the ability to plot any 
MDT standard sheet format.  This includes metric three-sheet files, single metric 
bridge files, metric GeoPak cross section files, 8.5 x 11 pavement preservation 
files, and 8.5 x 11 traffic sign design calculations.  The design file must be active 
in MicroStation in order for the local plotting option to work.  
(See section 3,LOCAL PLOTTING, pp14 - 29) 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Select Plot Current 
Design File 

Current MicroStation 
Design file 

Current CPB 
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5.3. Plot Current CPB Page 
DocuPlot will plot the current CPB page displayed in MicroStation. Default local 
and network plotter settings are determined in the plot parameter dialog and are 
independent of the CPB.  
    
 
 
 
 
 
 
 
 
 
 

Determine half or full size plans, 
grey scale, and number of copies 
 

Change Plotter, use default 
Windows XP plotter, or use 
current plotter. 

Select Plot Current CPB Page.  A fence plot of the 
MicroStation coordinates is sent to the selected 
plotter.  The local file is plotted, not the file on the 
CADD Server.  All files and reference files must be on 
the local c: drive.  

Active MicroStation file 
 

Current CPB page 
 

Current MicroStation coordinates  
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5.4. Plot CPB from Local (CPB Parameters) 
DocuPlot will plot specified pages of the local CPB.  DocuPlot allows for selecting 
CPB page parameters or check plot parameters.  DocuPlot brings each local 
design file, and specific sheets associated with the CPB into MicroStation. 
MicroStation fences and plots the contents, and submits the file to the plotter.   
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
  
  

5.5. 

Select Plot CPB from Local 
 

Exit returns to main 
DocuPlot screen 
 

Link to plotter choices in 
user settings 

Print Plots starts the local 
fence plotting 
 

Stop Prints cancels the 
print request. 

CPB page parameter uses the 
current plotter configuration. 
 

Select  CPB Page 
Parameters 
 

No options to pick 
a different plotter. 
 

Each page of the CPB is brought 
into MicroStation and the 
coordinates are fenced and plotted. 

Consecutive allows user 
to print consecutive 
sheets. 
 

Random determines 
range of sheets and 
random pages to plot. 
 

Number of copies. 
(maximum 10). 
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5.5 Plot CPB from Local (Check Plot Parameters) 
DocuPlot will allow the user to select any plotter at the check plot dialog or 
permanently change the plotter default settings. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Select Print Plots to start fence plotting 
process. 
 

Select Stop Print to abort Plotting 
process. 
 

Check Plot parameter uses the 
default plotter configurations set 
in DocuPlot User Settings. 
 

Options to pick a 
different plotter. 
 

Each page of the CPB is brought into MicroStation and 
the coordinates are fenced and plotted. 

Select Check Plot 
Parameters 
 

Consecutive allows user 
to print consecutive 
sheets. 
 

Random determines 
range of sheets and 
random pages to plot. 
 

Number of copies. 
(maximum 10). 
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5.6. Plot CPB From Network 
DocuPlot will plot specified pages of the server files in the CPB.  DocuPlot allows 
for choosing plot size, Grey Scale, plotter, specific sheets and number of copies.  
DocuPlot plots from the server and submits the file to the plotter.  The files are 
never brought into the local version of MicroStation.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Select Plot CPB from Network 

Submit Plots sends 
plot request to the 
network server. 

NOTE: To plot files from the network, only the 
Contract Plan Book is needed.  No MicroStation files 
are needed in the local drive. 
 

Options to pick a 
different plotter. 
 

Dialog showing the request 
sitting on the Network Plot 
Queue.  Choose close and 
you are retuned to main 
DocuPlot Screen. 

Consecutive allows user 
to print consecutive 
sheets. 
 

Random determines 
range of sheets and 
random pages to plot. 
 

Number of copies. 
(maximum 10). 
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5.7. Viewing and Deleting Network Plot Requests 
You can view the plotting queue and see all network plot requests.  Plot requests 
that you sent can be deleted. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select Utilities>Delete Network 
Plot Requests, your plots will be 
preceded with *****.  You may 
only delete plots you submitted. 

Select Utilities>View Network Plot 
Requests, your plots will be 
preceded with *****. 
 

To View the Network queue 

To delete your plot request 
from the Network queue 
 

The network server processes plot requests very 
quickly and the delete may not work.  If a big 
print job cannot be stopped at the queue, call ISB 
and have the job stopped at the printer where the 
job is being plotted. 

Only your plot requests will 
show.  Select the request 
and select delete.  
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6. DOCUPLOT USER SETTINGS 

6.1. U####. ini and U####.std Settings Files 
DocuPlot can be customized to each user through a *.ini file and a *.std file.  
These files are stored in the c:\etc directory.  A *.ini file is a setting file that 
records specific plotter settings for the individual user.  The *.std file is used to 
record specific dialog appearance settings for the individual user. 
 
 
 
 
 
 
 
 
 
 
 
 

 

Select Settings (button or from menu). 
 

Modifications for *.ini plotter 
settings 
 

Modifications for *.std 
MicroStation startup 
settings 
 

Modifications for *.std DocuPlot 
appearance settings 
 

*.INI file is by 
default the last 
saved *.ini file 
loaded into 
DocuPlot. 
 

Exit returns to main 
DocuPlot screen 
 

CONTINUED ON 
NEXT PAGE 
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U####.ini file 
controls DocuPlot 
plotter settings. 
 

U####.std file controls 
DocuPlot appearance 
settings. 
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6.2. U####.ini Plotter Settings 
DocuPlot has four plotter settings determined in an .INI file.  The User 
Information, the Final Plot Parameters, the Check Plot Parameters, and the 
Cross Section Parameters are all modified within an .ini file.  
 
 
 
 
 
 

 
 

Select Plotter Settings to view 
.INI settings 
 

Current .INI file 
 

Current User 
logged onto 
DocuPlot 
 

Current *.ini settings for 
submission to the Print Unit 
and for cross section 
submittals. 
 

Current *.ini settings for final 
plotting and creating CPB’s. 

Current *.ini settings for 
local plotting. 

Current *.ini settings for 
cross section plotting 
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6.3. Modify and Save User Information .INI Settings 
User information settings are for submission of plot requests to the Print Unit and 
for cross section submittals.  User information is set in the plot parameters 
portion of the .ini file. 
 
 
 
 
 
 

 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

To modify .INI User Information 
settings select Plotter Settings 

Current .INI file 
 

Fill in appropriate information.  
This data is used for print unit or 
cross section plot requests. 
 

Choose Save to 
save data to a *.INI 
file 

Highlight a file to overwrite, or 
key in a new file name with an 
.ini extension. 
 

Yes will update the selected 
*.ini file, and returns you to the 
settings dialog. 
 

Exit will stop 
updating the *.ini 
file and return you 
to the User 
Settings Dialog. 
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6.4. Modify and Save Final Plot Parameters .INI Settings 
Default plotter settings for CPB page parameters and network plot requests are 
set in the final plot parameter settings portion of the .ini file. 
 
  
 
 
 
 
 
 
 
 
 
   
 
  

Select Plotter to modify settings 
for final plot parameters.  Select 
the half-size and full-size plotters 
you want to set as default 
selections. 

Current .INI file 
 

Choose the plot size 
to modify.  

To modify .INI final plot settings 
select Plotter Settings 

Highlight a file to overwrite, or 
key in a new file name with an 
.ini extension. 
 

Yes will update the selected ini 
file, and returns you to the 
settings dialog. 
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6.5. Modify and Save Check Plot Parameters .INI Settings 
Default plotter settings for plotting current design file and check plot parameters 
are set in the check plot parameter settings portion of the .ini file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 

 
 
 
 
 
 
 
 
 

Current .INI file 
 

To modify .INI final plot settings 
select Plotter Settings 

Highlight a file to overwrite, or 
key in a new file name with an 
*.ini extension. 
 

Yes will update the selected 
*.ini file, and returns you to the 
settings dialog. 
 

Select Plotter to modify 
settings for final plot 
parameters.  Select the half-
size, full-size, and 8.5 x 11 
plotters you want to set as 
default selections. 

Choose the plot size 
to modify.  
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6.6. Modify and Save Cross Section Plot Parameters .INI Settings 
Default plotter settings for plotting cross sections are set in the cross section 
parameter settings portion of the .ini file. 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 

 
 
 
  
  
 
 
 
 
 
 
 
 
 
  
  
 
 
 
 
 
 
 
 
 
 

Current .INI file 
 

To modify .INI final plot settings 
select Plotter Settings 

Highlight a file to overwrite, or 
key in a new file name with an 
*.ini extension. 
 

Yes will update the selected 
*.ini file, and returns you to the 
settings dialog. 
 

Select Plotter to modify settings 
for final plot parameters.  Select 
the half-size and full-size plotters 
you want to set as default 
selections. 

Choose the plot size 
to modify.  
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6.7. Selecting and saving an .INI File 
A *.INI file may be brought in to DocuPlot and saved as the default settings for 
the plotter selections.  Multiple users can share a PC and have their own 
DocuPlot settings. 
 
   
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select Browse 
 

The c:\etc\ directory is 
opened using XP Explorer 
with a filter set to screen for 
*.ini files. 
 

Highlight the file you wish to 
load and click open. 
 

Note: 
This option works well when 
multiple users use one PC.   

Click OK to 
acknowledge saved 
settings. 
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6.8. Modify and Save MicroStation Startup STD Settings 
DocuPlot will open MicroStation using the startup settings set in the DocuPlot 
User settings.   
 
 
 
 
 
 
 
 
 
 
 

The Settings for MicroStation Startup will not be used until the next 
time DocuPlot opens MicroStation.   

Current .INI file 
 

To change the 
MicroStation Startup 
Settings choose an 
area from the drop 
down list. 

Click Save to save MicroStation 
startup settings to the 
U####.STD file. 
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6.9. Modify and Saving Color .STD Settings 
DocuPlot can be customized for cosmetic appearance.  The default appearance 
is gray and black.  These colors are modified using the User Settings dialog. 
 
 
 
 
 
 
 
 
 
 
 
 

Note: 
The color options in 
DocuPlot are for cosmetic 
appearances.  
 
The diagram on this page 
shows buttons in relation to 
one DocuPlot dialog.  The 
following page provides the 
modifying and saving color-
setting changes for one 
area.  All other color settings 
follow the same procedure. 
 

Current .INI file 
 

Resets colors to 
black and grey 
 

CONTINUED ON 
NEXT PAGE 
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Select portion of DocuPlot dialog 
to apply a new Color Setting to. 
 

Select Color and select OK 

OK to acknowledge 
saved settings. 
 

Select Save to update the 
attached u#####.std file. 

Note: 
 
All color settings for portions 
of the DocuPlot screen 
follow the same format 
shown on this page. 
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6.10. Load  .STD Settings File into DocuPlot 
The *.INI settings and *.STD files are separate entities.  They are linked together 
in the *.STD file using the SAVE command.  The User Settings LOAD command 
activates the settings within the current *.std file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Load brings the current settings 
in the *.STD file into Docuplot.  

Current .INI file loaded in to 
Docuplot.  The *.ini file controls all 
the plotter settings. 
 

Current *.STD file points to a 
specific *.INI file.  When Load is 
invoked, *.INI file will be loaded 
into Docuplot. 
 

NOTE: 
Load works as a default setting 
command.  It loads the last settings 
saved.  Any changes made to 
docuplot settings are not the default 
until Save is selected. 
 Save over writes the *.std file with 

current settings. 
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6.11. Load  .INI Settings File into DocuPlot 
The Plot Parameters LOAD command activates the settings within a selected 
*.ini file.  The Plot Parameters SAVE command writes to the *.ini file. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Select Plotter Settings 

NOTE: 
To save loaded *.ini settings as 
a u####.ini file for DocuPlot 
plotter settings, return to the 
User Settings Dialog and select 
Save. 
 
By not selecting save, the 
loaded .ini file is used for 
temporary plotter settings. 
 

Selected .INI file loaded 
in to Docuplot.  The *.ini 
file controls all the 
plotter settings. 
 

Select Load 

Highlight a file and 
select Open.   
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7. BUILD NEW CPB BOOK 
DocuPlot builds electronic CPB’s, (Contract Plans Books).  A CPB is an 
electronic script file that contains a page for, CADD Server data, design file 
name, and sheet coordinates.  A CPB is a sequential order of MicroStation 
design files for the contract plan package. 
 

7.1. Determine Project #### and Area for CPB 
A CPB can only be built using projects and areas that a user has write access to. 
 
 
 
 
 
 
 
 
 
 
 
  

 
 

NOTE: 
Selection dialog will only display 
projects you have write access to.   

Select Accept, and the 
DocuPlot Build Sheets 
(New) dialog will return.  
The current project 
information is entered. 
 

Exit returns you to the 
Build Sheets (New) 
Dialog. 
 

Choose Select Project” 
 

Select Build New Book 
 

Highlight the project  
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7.2. Build Plan Sheet CPB - Insert Local File After Current Page 
A design file, (CPB page), can be added after the current page. Every book starts 
with page 0 and is labeled MDT.MAS.  To add a page select a local design file 
and sheet number to add into the CPB.  
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Current project data NOTE: 
Local files not backed up on a CADD 
server may be added to a CPB. Local files 
brought down from the CADD server 
through CADD Access may be added to a 
CPB.  
A local file not backed up on the CADD 
server will not be accepted by Contract 
Plans.  

Choose Select Local File 

Filters for file extension set in 
U####.INI file, (see Section 6.8, 
Modify and Save MicroStation 
Startup STD Settings, pp.55). 

Highlight a file in the c:\dgn 
directory, and select open, (or 
double click). 
 

Selected MicroStation design file into 
DocuPlot Build Sheets dialog box 
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7.3. Build Plan Sheet CPB - Insert Sheet from Local File 
To add a specific sheet in a design file into the CPB, click the select sheet option.  
Every book starts with page 0 and is labeled MDT.MAS.  When creating the 
contract plans add the required sheets in sequential order. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 

Select Accept, return to the 
DocuPlot Build Sheets 
dialog. 

Select sheet type, and 
Current Selection 
displayed 

See Section 12, APPENDIX B – 
SHEET TYPES FOR 
INSERTING INTO CPB, pp. 89, 
for a description of the sheet 
types, and the dialogs 
associated with the selection 
 

Current project data 
and design file 
 

Select specific sheet 
number to add to the 
CPB.   
 
Select Accept and the 
page is added. 
 

Current page in the 
CPB being added 
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7.4. Build Plan Sheet CPB - Insert Additional Sheets from Local File 
To add additional sheets from the current design file into the CPB, click an 
unchecked sheet.   Continue to add sheets in sequential order required in the 
contract plan submittal. 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Current page in the 
CPB being added 

Select specific sheet 
number to add to the 
CPB.   
 
Select Accept and the 
page is added. 
 

Current page in the 
CPB being added 

Select specific sheet 
number to add to the 
CPB.   
 
Select Accept and the 
page is added. 
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7.5. Build Plan Sheet CPB - Insert Additional Sheets New Local File 
To add additional sheets from a new local design file into the CPB, click on 
Select Local File. The reset button will refresh the last sheet style selected. 
Continue adding sheets to the contract plans in sequential order.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

Select specific sheet 
number to add to the 
CPB.   
 
Select Accept and the 
page is added. 
 

Highlight a file in the c:\dgn 
directory, and select open, (or 
double click). 
 

Select a MicroStation design file in the 
DocuPlot Build Sheets dialog box 
 

Reset button refreshes 
sheet layout of previous 
selected sheet style. 
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7.6. Build Plan Sheet CPB – Insert sheets from CADD Server Files 
A CADD server design file, (CPB page), can be added after the current page. To 
add a network file, Select CADD Server file and sheet number to add into the 
CPB. 
 
 
 
 

Current page in the 
CPB being added 

Select specific sheet 
number to add to the 
CPB.   
 
Select Accept and the 
page is added. 
 

Highlight a file in the pop up 
menu, and select Accept (or 
double click). 
 

Reset button refreshes 
sheet layout of previous 
selected sheet style. 
 Select a MicroStation design 

file in the DocuPlot Build 
Sheets dialog box 
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7.7. Build Plan Sheet CPB – Finish CPB and Load into DocuPlot 
After building the contract plans book in the sequential order required, choose 
exit to return to the main DocuPlot dialog.  Load the new book into DocuPlot 
using Load Book. 
 
 
 
 
 
 
 

Exit stops building the 
book, names the CPB and 
places it in the c:\dgn 
directory.  The next screen 
is the main DocuPlot 
dialog.  

The CPB will 
automatically load into 
DocuPlot when there 
was no current book 
loaded prior to building 
the CPB. 
 
However, if there was a 
current book loaded 
while the new CPB was 
being built, you will need 
to load the newly 
created book. 

Design area 
abbreviation 
 

Project 
control 
number 

pre = preliminary CPB 
fnl= final CPB 

CPB = contract plan book 
 

Default CPB Naming convention 

ZBGR RD PRE 002 . CPB 

002 = series number 
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7.8. Build Cross Section CPB 
Cross Section sheets are placed in a CPB separate from other plan sheets.  
Cross sections cannot be inserted into an existing CPB.  If a cross section CPB 
needs to be revised it is easier to rebuild the file.  A cross section CPB and plan 
sheet CPB can be merged after the two files are built separately. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Highlight the project 
and select Accept 
 

Select Build New Book 

Choose Select Project 
 

Select Local or CADD Server File 
 Highlight the project 

and select Accept 
 

CONTINUED ON 
NEXT PAGE 
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The DocuPlot Build Sheets 
(New) dialog will return 
with current project 
information entered. 
 

Select Cross Sections (option only 
available when a cross section file is 
selected). 
 

Select the type of cross sections, and the 
method the cross sections were created. 

Okay creates the CPB book, 
returns main DocuPlot dialog 
with cross section CPB 
loaded. 

Specify the cross section 
sheets required (1 – 500). 

Design area 
abbreviation 
 

Project 
control 
number 

pxs = preliminary cross sections 
fxs = final cross sections 

CPB = contract plan book 
 

Default Cross Section CPB Naming convention 

CADD RD PXS 002 . CPB 

002 = series number 
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8. EDITING AN EXISTING CPB 
An existing CPB, (Contract Plans Book) can be edited.  Pages can be added, 
pages can be replaced, pages can be deleted, and the pages can be reordered.  
 

8.1. Edit CPB - Insert Page(s) after Current Page 
You can insert design file sheets into an existing CPB.  Pages can be inserted 
after another page using, Insert After Current Page.  However, new pages that 
need to be added to the front of the CPB must be inserted at the back of the 
CPB.  The CPB must then be reordered, placing the last sheet at the front. 
 
 
 
 

Select sheet 

Highlight a file to insert 

Select Insert After 
Current Page 
 

Current CPB and 
page of the book 
 

Project Data already 
defined by current 
book 
 

CONTINUED ON 
NEXT PAGE 
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Select specific sheet 
number to add to the 
CPB.   
 
Select Accept and the 
page is inserted into 
the book. 
 

Continue adding new 
files and sheets to the 
CPB as necessary.  
 

Select Exit to return to 
Main DocuPlot dialog 
with revised CPB 
loaded. 
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8.2. Edit CPB - Save Current Page 
Saving a current page replaces the current CPB page with the active design file 
displayed in MicroStation. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Current design file 
and coordinates for 
CPB page 
 

Scroll to the CPB 
page to be replaced. 
 

Design file opens to 
use as replacement 
 

Use DocuPlot Fence 
coordinate buttons to 
display sheet required 
 

After displaying 
proper page in 
MicroStation select 
Save Current Page 

Yes to replace page 
No to not replace page 
 

Use DocuPlot’s * 
button to open a new 
file 



DocuPlot Users Manual   June 25, 2004 
 

 - 72 - 

      

8.3. Edit CPB – Delete Current Page 
DocuPlot will delete a sheet, within a loaded CPB, one page at a time. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

Page deleted and CPB 
shortened by one page 
 

Scroll to the CPB 
page to be deleted 
and select Delete 
Current Page 
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8.4 Edit CPB – Reorder CPB Pages  
DocuPlot will allow the user to reorder the sequence of pages within a CPB. 
 
 
 
 
 
 
 
 
 
 
 

 

Choose before or after placement.  
Drag and drop from left column to 
new location in right column. 
 

Current CPB 
 

Okay reorders the pages and asks to 
save the modified CPB. 
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Save as screen asks for a name to 
save the book.  By default the original 
name is highlighted.  
 

Saving the book with the original name 
brings up a prompt to replace existing 
file.  Click yes. 
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9. APPEND CPB BOOKS 
Once separate Contract Plan Books are created, the individual books may need 
sheets appended or the individual books may be appended together.  The 
concept is to have one book, made up of little books, for a design project.  
Appending books for final bid package will be done by contract plans. 

9.1. Append Contract Plan Books 
DocuPlot will append individual CPB’s into one large book.  The books should be 
appended in the order that final plotting needs to occur. 
 
 
 
 
 
 
 
 
 
 
 
 

 

Select Append Book 
 

Select Append 
Contract Plan 
Books 
 

Do not have active CPB 
 

CONTINUED ON 
NEXT PAGE 
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Default search 
path is c:\dgn 
 

Clear removes any files 
selected from the right 
side of the dialog 

Highlight the files in the 
sequence the files need 
appending.  

Select to move 
the files to the 
right 
 

Save as creates a 
new CPB file,  
 

Exit returns to main 
DocuPlot screen.  
 
To view new appended 
CPB, load the book into 
DocuPlot  
 

Page #, is the series of 
CPB’s, in this case 
there are three pages.  
 
The Done prompt 
indicates all selected 
books are appended. 

Enter name of new appended 
CPB, default path is c:\dgn, 
select Save, and return to Join 
Contract Plan Books dialog. 
 

The order of files is top 
to bottom  
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9.2. Append Sheets to a Contract Plans Book 
DocuPlot will allow the user to append sheets to an existing CPB.  These sheets 
are added to the end of the CPB.  This option meets the Contract Plans 
addendum process. 
 
 
 
 
 
 
 
 
 
 
 

 

Select Append Book 
 

Exit returns to main 
DocuPlot screen 
 

Select Append Sheets to A 
Contract Plan Book 
 

Select a CPB file to append 
sheets to, select Open, and the 
Build Sheets (append) dialog 
box opens. 

Default directory is c:\dgn 
 

CONTINUED ON 
NEXT PAGE 
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Project number, design area and 
CADD server associated with CPB are 
loaded into DocuPlot 
 

Next available page in 
the CPB is ready to 
accept design file 
information. (In this 
example, pages 1-11 
are used.  Page 12 is 
blank.) 
 

Select Local file or Select 
CADD Server File. 
 

Select a file, either local or from 
CADD server and Open / Accept. 
 
The Build Sheets (Append) 
Dialog will return with the design 
file loaded into DocuPlot. 

CONTINUED ON 
NEXT PAGE 
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The appended book is now 
loaded into DocuPlot, and can be 
plotted as any CPB file. 

Note: 
 
If an area CPB is appended with new sheets and this 
new area CPB is part of a final appended contract 
plan book, the final appended book will not reflect the 
changes. 
 
CPB’s do not work like reference files; therefore a 
new final Appended Contract Plan Book will have to 
be created.  (See Section 9.1, Append Contract 
Plan Books, pp. 75) 

Select the appropriate 
sheet type. 

Add the appropriate 
sheets to append the 
CPB. Select additional 
files and sheets as 
necessary. 
 
Select Exit to return to 
the main Docuplot 
Dialog. 
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10. DOCUPLOT USERS WITH PRIVILEGES 
Select users on each crew will be granted privileges to send plot requests directly 
to the print unit.  DocuPlot privileged users have a very powerful tool that allows 
the user to automatically bring design files in a CPB down from the server.  
Having privileges allows the user to view reference files attached to a design file 
from the CADD server. 
 

10.1. Privileged User’s DocuPlot Screen 
The DocuPlot screen will only appear different once a CPB is loaded into 
DocuPlot. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

After a CPB is loaded into DocuPlot the privileged 
user will have two extra options on the main menu.  
Toggles for Use Local Files and Use Local Reference 
Files are on a privileged users screen. 
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10.2. Use Local Design Files Toggle 
A privileged user can use the existing local files or they can bring down a fresh 
copy off of the CADD server when paging through the CPB.  Anytime a fresh 
copy of a file is transferred to the local machine it will overwrite the existing file. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

With the Use Local Design File OFF, 
a privileged user can bring a fresh 
copy of the CPB page from the 
CADD server or use the local version 
of the file. 

With the Use Local Design File ON, 
the local version of the file in the 
CPB will always be used. 

Yes will overwrite the local 
file.  If changes have been 
made to the local file, these 
changes will be lost. 
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10.3. Use Local Reference Files Toggle 
When viewing a CPB, a privileged user can view the attached reference files of a 
local design file locally or off the CADD Server.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

With the Use Local Reference File 
ON, the reference files are mapped 
to the appropriate file located on the 
c:\dgn\ref subdirectory.  

With the Use Local Reference File 
OFF, the reference files are mapped 
to the appropriate CADD server. 
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10.4. Plotting Directly to the Print Unit 
Privileged users have all the same print options with the addition of printing 
directly to the print unit.   Plotting to the print unit is only available in the Plot CPB 
from Network option and in plotting cross section files. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Load the CPB into 
DocuPlot and select Plot 
CPB from Network. 

Select plot size, grey scale option, 
to print shop and sheets required. 

Fill out electronic request form, 
which is sent to the print unit’s 
printer.  The plots will be sent to 
the appropriate print unit server for 
printing.  The Print Unit will notify 
you when the job is completed. 

Submit request displays a MS Word preview of the print unit request 
document and then the document is sent to the Print Unit’s printer. The 
plots are sent to the print units server and the network plot queue is 
displayed.  
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10.5. Options when Plotting CPB from Local 
When plotting local files in a CPB a privileged user can use only local files or 
bring fresh copies of all files down from the CADD server. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 

Load the CPB and select 
Plot CPB from Local 

Select file parameter of 
using only local files, or 
copy files from the file 
server.  Copying the files 
will result in the local files 
being overwritten. 
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10.6. Plotting Cross Sections to the Print Unit 
Users with privileges can send cross section plots directly to the print unit.  Cross 
sections can be plotted as a CPB or as a single local file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
  

Open the cross section 
file in MicroStation 

Select Plot Current 
Design File 

Select to Print Shop, 
only the cross section 
options will be available 
to plot.   

Fill out electronic request form, which is 
sent to the print unit’s printer.  The plots 
will be sent to the appropriate print unit 
server for printing.  The Print Unit will 
notify you when the job is completed. 

Submit request displays a MS Word 
preview of the print unit request 
document and then the document is 
sent to the Print Unit’s printer. The 
plots are sent to the print units server 
and the network plot queue is 
displayed. 
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11. APPENDIX A – CPB FILE NAMING STRUCTURE 

11.1. DocuPlot CPB Files and LST Files 
A DocuPlot CPB follows default-naming structure when the book is created.  
The name uses a Control Number: Design Area: Version ###. CPB format. 
CPB’s can be renamed in NT Explorer.  This structure follows the DMS 
(Document Management System) file naming structure.  Contact plan books 
are stored on the CADD server. For cross section CPB naming see section 
7.8, Build Cross Section CPB, pp. 67. 
 

9999  rd  pre  001 . cpb 
 
 
 
 
 
 
 
Contract plan books are created local and saved to the appropriate CADD 
server.  DocuPlot by default looks in the c:\dgn subdirectory when loading 
CPB’s.  If an additional CPB is created using the same project information, 
DocuPlot will automatically name the file with new version number. 
 
The DocuPlot Utility, List contact Plan Information, creates a *.LST file.  This 
file has the same CPB name with an .lst extension.  This is a database-
indexing file.  This file can be deleted.  
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 

Design area 
abbreviation 
 

Project 
control 
number 

pre = preliminary 
fnl = final 
 

CPB = contract plan book 
 

A  *.LST file is a contract plan book indexing file. *.LST files can be deleted.  Every time 
the DocuPlot Utility List contact Plan Information is run on a CPB a new *.LST file is 
created. 

A *.CPB files is a contract plan 
book file, maintain final version 
on the CADD Server. 
 

001 = version number 
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11.2. DocuPlot .INI Files and .STD Files 
DocuPlot organizes its settings into two separate files.  A *.INI file controls the 
default plotting settings for individual users.   
 
A *.STD file controls the appearance of the DocuPlot dialogs, and is the link 
between the two files. 
 
Both the .INI and .STD files are kept on the c:\etc subdirectory.  It is prudent to 
back your individual files on your U drive. 
  
 
 
 
 
 
 
 
 
 
 
  
  
  

 

Plotter selected for printing 

Link to *.INI file 

The *.STD file controls all the 
appearance related settings 
for DocuPlot.  The .STD file 
can be specific to individual 
users or can be set up to 
serve a design area.  (See 
Section 6, DOCUPLOT USER 
SETTINGS, pp. 47-59) 

DocuPlot dialog 
color settings 

Main DocuPlot dialog 
screen coordinates on XP 
Windows’s desktop. CONTINUED ON 

NEXT PAGE 
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The *.INI file controls all 
the plotter related 
settings for DocuPlot.  An 
.INI file can be specific to 
individual users or can be 
set up to serve a design 
area.  (See Section 6, 
DOCUPLOT USER 
SETTINGS, pp. 47-59) 
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12. APPENDIX B – SHEET TYPES FOR INSERTING INTO CPB  
DocuPlot supports a variety of sheet types that can be placed into a CPB.  
DocuPlot supports current standards for each design area as well as legacy 
formats. 

12.1. Standard Three Plan Sheets 
 
 
 
 
 
 
 
 
 
 
 

 

Select Type of Sheet 
 

Select one sheet from 
the three-sheet format. 
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12.2. Standard Bridge Plan Sheets 
  
 
 
 
 
 
 
 
 
 
 

 

Select Bridge Metric 
 

Select single sheet from 
the one-sheet format. 
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12.3. Legacy Plan Sheets 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Select Other Style Sheets 
 

Select sheet location 
from the sheet format 
displayed. 
 

Select legacy sheet style used 
in the file being placed into the 
CPB. 
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12.4. Cross Section Sheets 
Cross Section sheets are placed in a CPB separate from other plan sheets.  It is 
easier to rebuild a cross section CPB, rather than trying to insert pages.   
 
  
 

Select Cross Sections, option only available when a cross section 
file is selected. 
 

Specify the sheets to 
plot (1 – 500). 

Select the type of cross 
sections scale, and the 
method the cross sections 
were created. 

Okay creates the CPB book 
and returns you to main 
DocuPlot dialog. 
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13. APPENDIX C – CPB’S FROM NON STANDARD SHEETS 
Contract Plan Books can be built from any style of sheet.  All that is in a CPB is 
the CADD Server information, the file, and the coordinates.  Non-standard sheets 
in DocuPlot will require the coordinates to be entered manually. 

13.1. Create a Bogus CPB 
Create a CPB that is approximately the same size and length of the bogus plots.  
Simply create a book of blank pages.  The next step will be to replace each page 
with the correct file and correct coordinates. 
 
 
 
  
 
   
 
 
 
 
 
 
 
 
 
 
 
 

Select the appropriate 
project. 

Select Build New Book 

Select any local MicroStation 
file.  This is a bogus book, 
so file does not matter Select the sheets to 

insert.  Again these are 
blank pages. 

CONTINUED ON 
NEXT PAGE 
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Select any style of sheet to insert.  
This is a bogus book, the final 
pages will be added later.  All that 
is needed is a book of pages to 
work from, (cross-section books 
are very quick to build). 

A bogus book of 20 pages is built.  
This book will be renamed in NT 
Explorer to reflect a CPB of plan 
sheets and not cross sections. 
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13.2. Determine Coordinates for Non-Standard Sheets 
Each sheet to be used as a new page in the CPB has coordinates that must be 
recorded.  These coordinates will be used during the editing CPB process.  It 
may be helpful to create a Notepad, Excel, or Word document.  The cut and 
paste method works best as it eliminates manual entering of numbers, and 
eliminates some error. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Active MicroStation Drawing that 
will become first page in the CPB. 

Use the Label Point Coordinate 
command.  The format of the label 
for DocuPlot is x and y separated 
by a comma with no prefix. 

Select the text in MicroStation,  
use Edit > Copy to put text into 
clipboard. 

Edit > Paste to put clipboard text 
into the document. 
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13.3. Save Design File with Non-Standard Coordinates 
Each page in the bogus CPB will need to be replaced with the file name and 
coordinates of the non standard sheets.  See section 8, 
Edit CPB - Save Current Page, pp. 71, for the editing method used in saving 
files displayed in MicroStation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Load the Bogus CPB 

Move to the page in the CPB 
that will be replaced and 
open the local file that will 
replace the page. 

CONTINUED ON 
NEXT PAGE 



DocuPlot Users Manual   June 25, 2004 
 

 - 97 - 

 
  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Open document with coordinates for the 
new sheets.  Copy the appropriate 
coordinates for the sheet being replaced. 

Paste the new coordinates in 
the fence coordinates dialog. 

Select Save 
Current Page 

Highlight Enter New Full-Size 
Sheet Fence Coordinates and 
dialog will reflect new value 
pasted into fence coordinates 

The new file and fence 
coordinates are now stored for 
the appropriate page.  Follow 
the same procedure for the 
remaining portion of the CPB.  
Delete any unused CPB 
pages. 

Use only the 
scroll bar in the 
CPB pages 
dialog to move 
through the files. 
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